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 IMPORTANT – READ CAREFULLY:
This product is for commercial use only. 

This Process License Agreement (“PLA”) is a legal agreement between you and 
Sawgrass Technologies, Inc. (“Sawgrass”). By installing the ChromaBlast™ cartridge 
in your printer, or otherwise using the Sawgrass ChromaBlast™ ink, you agree to be 
bound by the terms of this PLA. If you do not agree to the terms of this PLA, Sawgrass 
is unwilling to license the process of using the ChromaBlast™ ink to you. In such event, 
you may not use the ChromaBlast™ ink, and you should promptly contact your supplier 
for instructions on return of the unopened package.

The process of using ChromaBlast™ ink is protected by U.S. and foreign patents. 
Sawgrass will provide a complete list of the relevant patents upon request. The use of 
the ChromaBlast™ ink to practice the patented process is permitted by this license.

1.	 GRANT OF LICENSE.
	 This PLA grants you the following rights: 
	 You may install and use the ChromaBlast™ ink packaged herewith in your EPSON
	 printer to practice the printing process described in U.S. Patent No. 6,341,856
	 (“Sawgrass Process”).  The use of any ink, dye or pigment to practice the Sawgrass
	 Process, other than a ChromaBlast™ ink purchased from Sawgrass or its authorized 
	 distributor accompanied by a PLA, is not a licensed use of the Sawgrass Process. 
	 No rights to use the Sawgrass 	Process, except those specified herein, are granted, 
	 and no rights to use any other process, product, software or hardware developed or
	 sold by Sawgrass are 	granted or implied hereby.

2.	 LIMITATIONS ON REVERSE ENGINEERING 
	 You agree that you will not attempt to reverse engineer, reproduce or deformulate 	
	 the ChromaBlast™ ink.

3.	 PATENTS AND COPYRIGHTS 
	 Sawgrass owns multiple U.S. and foreign patents which may apply to the Sawgrass 
	 Process and/or the use of ChromaBlast™ ink. All patents in and to the method of
	 using ChromaBlast™ ink are owned by Sawgrass Technologies, Inc. You may
	 not copy the printed materials accompanying the ChromaBlast™ ink. All rights not 
	 specifically granted under this PLA are reserved by Sawgrass Technologies, Inc.

Sawgrass agrees to replace any defective product, within a reasonable time, which shall 
be Sawgrass’ sole responsibility for errors or defects in the goods.  THERE ARE NO 
OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. SAWGRASS SHALL NOT BE LIABLE FOR LOSS OF PROFIT OR OTHER 
ECONOMIC LOSS, OR FOR INDIRECT, SPECIAL, CONSEQUENTIAL OR OTHER SIMILAR 
DAMAGES.

Rev.2.0_022509JCR
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END-USER LICENSE AGREEMENT FOR SAWGRASS 
SOFTWARE—ChromaBlast Driver™ 
IMPORTANT-READ CAREFULLY: This Sawgrass Technologies Inc. End-User License 
Agreement (“EULA”) is a legal agreement between you (either an individual or a single 
entity) and Sawgrass Technologies, Inc. for the Sawgrass software product identified 
above, which includes computer software and may include associated media, printed 
materials, and “online” or electronic documentation (“SOFTWARE PRODUCT”). By 
installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound 
by the terms of this EULA. If you do not agree to the terms of this EULA, do not install or 
use the SOFTWARE PRODUCT.

Software PRODUCT LICENSE
Copyright laws and international copyright treaties, as well as other intellectual property 
laws and treaties protect the SOFTWARE PRODUCT. The SOFTWARE PRODUCT is 
licensed, not sold.  The title to, and ownership of, this SOFTWARE PRODUCT remains 
with Sawgrass Technologies, Inc. (Sawgrass).

GRANT OF LICENSE. This EULA grants you the following rights:

	 •	 This license is provided to you for your use according to the terms hereof.  You
		  may install and use the SOFTWARE PRODUCT packaged herewith to practice
		  the printing process described in U.S. Patent No.  5,488,907 (the “Sawgrass
		  Process”).  The use of any ink, dye or pigment to practice the Sawgrass
		  Process, other than a ChromaBlast™ ink which is purchased from Sawgrass or
		  its authorized distributor, is not a licensed use of the SOFTWAREPRODUCT. 
		  You agree not to use the SOFTWARE PRODUCT for any other purpose
		  or in any process except as expressly permitted hereby. 

	 •	 Not for Resale. You may not sell, or otherwise transfer for value, the SOFTWARE 
		  PRODUCT.

	 •	 No Reverse Engineering, Decompilation, Copying or Disassembly. You may
		  not reverse engineer, decompile, copy or disassemble the SOFTWARE
		  PRODUCT.	
	 •	 No Rental. You may not rent, lease, or lend the SOFTWARE PRODUCT. 

	 •	 Support Services. Sawgrass Technologies, Inc. may provide you with support
		  services related to the SOFTWARE PRODUCT (“Support Services”). 	 Use of
		  Support Services is governed by the Sawgrass policies and programs described
		  in the user manual, in “online” documentation, and / or in other Sawgrass-
		  provided materials. Any supplemental software code provided to you as part
		  of the Support Services shall be considered part of the SOFTWARE PRODUCT
		  and subject to the terms and conditions of this EULA. With respect to technical
		  Information you provide to Sawgrass as part of the Support Services, Sawgrass
		  may use such information for its business purposes, including for product
		  support and development. Sawgrass will not utilize such technical information
		  in a form that personally identifies you.
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	 •	 No Assignment or Sublicense.  You may not assign or sublicense the rights 	
		  granted 	hereby.  

	 •	 Termination. Without prejudice to any other rights, Sawgrass may terminate 	
		  this EULA if you fail to comply with the terms and conditions of this EULA. 	
		  In the event of termination, you must destroy all copies of the SOFTWARE 	
		  PRODUCT and all of its component parts.

COPYRIGHT.  All title and copyrights in and to the SOFTWARE PRODUCT (including 
but not limited to any images, photographs, animations, video, audio, music, text, and 
“applets” incorporated into the SOFTWARE PRODUCT), the accompanying printed 
materials, and any copies of the SOFTWARE PRODUCT are owned by Sawgrass 
Technologies Inc. or its suppliers.  Copyright laws and international treaty provisions 
protect the SOFTWARE PRODUCT.  Therefore, you must treat the SOFTWARE PRODUCT 
like any other copyrighted material, except that you may install the SOFTWARE PRODUCT 
on a computer for the uses permitted hereby. You may not copy the printed materials 
accompanying the SOFTWARE PRODUCT.   You may not loan, rent, lease, or otherwise 
transfer the other medium to another user, except as part of the permanent transfer (as 
provided above) of the SOFTWARE PRODUCT.

U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE PRODUCT and 
documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure 
by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the 
Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or 
subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights 
at 48 CFR 52.227-19, as applicable.

MISCELLANEOUS

	 a.	 If you acquired this product in the United States, this EULA is governed by 	
		  the laws of the State of South Carolina.  In the event of any dispute arising 	
		  under this license or from the use of the SOFTWARE PRODUCT, each party 	
		  irrevocably agrees to the jurisdiction of the United States District Court for 	
		  the District of South Carolina, Charleston Division. 

	 b.	 If you acquired this product in Canada, this EULA is governed by the laws of 	
		  the Province of Ontario, Canada. In the event of any dispute arising under this 	
		  license or from the use of the SOFTWARE PRODUCT, each party irrevocably 	
		  agrees to the jurisdiction of the courts of the Province of Ontario and further 	
		  agrees to commence any litigation which may arise hereunder in the courts 	
		  located in the Judicial District of York, Province of Ontario. 

	 c.	 If this product was acquired outside the United States, then local law may 	
		  apply.
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LIMITED WARRANTY. Sawgrass warrants that (a) the SOFTWARE PRODUCT will 
perform substantially in accordance with the accompanying written materials for a period 
of thirty (30) days from the date of receipt, and (b) any Support Services provided by 
Sawgrass shall be substantially as described in applicable written materials provided to 
you by Sawgrass, and Sawgrass support engineers will make commercially reasonable 
efforts to solve any problem issues. Some states and jurisdictions do not allow limitations 
on duration of an implied warranty, so the above limitation may not apply to you. To the 
extent allowed by applicable law, implied warranties on the SOFTWARE PRODUCT, if 
any, are limited to thirty (30) days.

CUSTOMER REMEDIES. Sawgrass’ and its suppliers’ entire liability and your exclusive 
remedy shall be, at Sawgrass’ option, either (a) return of the price paid, if any, or (b) 
repair or replacement of the SOFTWARE PRODUCT that does not meet Sawgrass’ 
Limited Warranty and which is returned to Sawgrass with a copy of your receipt. This 
Limited Warranty is void if failure of the SOFTWARE PRODUCT has resulted from 
accident, abuse, or misapplication. Any replacement SOFTWARE PRODUCT will be 
warranted for the remainder of the original warranty period or thirty (30) days, whichever 
is longer. Outside the United States, neither these remedies nor any product support 
services offered by Sawgrass are available without proof of purchase from an authorized 
international source.

NO OTHER WARRANTIES. To the maximum extent permitted by applicable law, 
Sawgrass and its suppliers disclaim all other warranties and conditions, either express 
or implied, including, but not limited to, implied warranties of merchantability, fitness 
for a particular purpose, title, and non-infringement, with regard to the SOFTWARE 
PRODUCT, and the provision of or failure to provide Support Services.  This limited 
warranty gives you specific legal rights. You may have others, which vary from state/
jurisdiction to state/jurisdiction.

LIMITATION OF LIABILITY. To the maximum extent permitted by applicable law, in no
event shall Sawgrass or its suppliers be liable for any special, incidental, indirect, or
consequential damages whatsoever (including, without limitation, damages for loss
of business profits, business interruption, loss of business information, or any other
pecuniary loss) arising out of the use of or inability to use the SOFTWARE PRODUCT or 
the provision of or failure to provide Support Services, even if Sawgrass has been
advised of the possibility of such damages. In any case, Sawgrass’ entire liability
under any provision of this EULA shall be limited to U.S. $5.00. Because some states
and jurisdictions do not allow the exclusion or limitation of liability, the above limitation
may not apply to you.

ChromaBlast™ ink, ChromaBlast™ v1.5 media, ChromaBlast Driver™ v1.5, and Color
Sure™ are Trademarks of Sawgrass Technologies, Inc.

General Notice: Other product names used herein are for identification purposes only
and may be trademarks of their respective owners.  Sawgrass Technologies, Inc.
disclaims any and all rights in those marks.
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Document Overview
Congratulations on your purchase of the R1900 System featuring ChromaBlast Digital Transfer 
Inks. The ChromaBlast Digital System, designed to work with the Epson Stylus Photo R1900 
Printer, is the latest advancement from Sawgrass Technologies, Inc., a leader in the development 
of digitally-driven color transfer technologies and related products.

The ChromaBlast Digital System for the Epson Stylus Photo R1900 includes ChromaBlast Inks, 
and the ChromaBlast R1900 Driver. You will also need ChromaBlast Transfer Media to achieve 
soft, permanent digital images on cotton garments. This revolutionary system takes sublimation 
and cotton decoration to the professional level, allowing users to create perfect transfers on a 
wide variety of substrates with minimal effort.

With the ChromaBlast Digital System, you can digitally decorate any polyester, poly-coated 
or light-colored cotton product. Your imagination is the only limit for producing brilliant, photo 
quality images on caps, clipboards, clocks, mugs, mouse pads, plaques, puzzles, synthetic or 
cotton T-shirts… and all points in between.

The ChromaBlast R1900 Driver is user-friendly software that enables you to select your inset 
and control your color output. The ChromaBlast R1900 Driver bundles color management 
software with the ChromaBlast print driver, giving you a powerful combination of customized 
color options. By using the ChromaBlast R1900 Driver to print with ChromaBlast Inks onto 
ChromaBlast Media, your images transfer flawlessly to any white or light colored cotton product, 
such as t-shirts, grocery bags, caps… and more. The ChromaBlast Digital System for the Epson 
Stylus Photo R1900 Ink-Jet Printer is ideal for markets that specialize in short run personalized 
or customized products.

This document contains information for using ChromaBlast Digital Transfer Inks, as well as 
helpful tips for getting the best results from your transfers. The information provided pertains 
specifically to the use of ChromaBlast Digital Transfer Inks in your Epson Stylus Photo R1900 
Ink-jet Printer, and is not meant as a substitute for the printer’s original operation manual.

NOTE: If you have questions about the operation of your EPSON Printer, refer to the Epson Stylus 
Photo R1900 Ink-jet Printer User’s Guide.

Technical Support is available from your Authorized ChromaBlast Digital System reseller, or 
directly from Sawgrass Technologies, Inc. See the section entitled Technical Support on Page 
66 for additional information.

We at Sawgrass Technologies strive to provide you with the tools to make the sublimation and 
cotton decorating process easy to learn and simple to master. We hope you will find that the tools 
we have developed will make your years in the sublimation and cotton decoration business fun 
and profitable. Please feel free to contact us with your feedback about or products. For additional 
information about our other products, please visit our website at www.sawgrassink.com.

Thank you and enjoy your ChromaBlast Digital System…
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About this Document
This document contains descriptions and procedures for using ChromaBlast™ Digital 
Transfer Inks, along with additional information for getting the best results from your 
transfers. 

The documentation provided pertains only to the use of ChromaBlast™ Digital Transfer 
Inks in your Epson Stylus Photo R1900 Ink Jet Printer.  To assist you in the overall setup 
process, references are made back to the instructions contained in the Epson Stylus 
Photo R1900 Quick Reference Printer Basics Guide.

	 To help point out important information, specific instructions, and 	
	 helpful tips, look for the following symbols:
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Figure 1

Figure 2 Figure 3

Figure 4

Control Panel Graphic

Ink Cartridge Setup for the R1900
1.	 Plug the Power Cable into the Printer and the appropriate power outlet. (Figure 1.)

2.	 Turn Printer on, (Figure 2), lift lid, (Figure 3), and press Cartridge Replacement 	
	 Button. (In Red, “Ink Button”, Figure 4).
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4.	 Press each cartridge body until it engages securely.  

Do not shake or agitate ink carts before or after installation.  
CAUTION:

3.	 Insert the ChromaBlast™ cartridges in the indicated order.

Figure 5

INSTALLATION ORDER

Figure 6

2.	 The cartridge bay will shift into the “Remove” position. Lift the bay lid and remove
	 any installed cartridges. (See Inset in Figure 3, Page 5).
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6.	 Press the Ink Button. (Please see Control Panel Graphic above.) This will move
	 the Print Head into it’s “Parked” position, completing the Ink Cartridge 		
	 Installation for the R1900 Printer.

Next on the agenda is the loading of the software, ChromaBlast Driver R1900, for 
the Epson Stylus® Photo R1900 Inkjet Printer.

5.	 Once all cartridges are in place, close the cartridge bay lid and press to engage.

Figure 8

Control Panel Graphic

Figure 7
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QuickConnect® BULK INK SYSTEM Installation Guide
				    Please read this document thoroughly before installing the system
				    to prevent voiding your warranty. For more detailed instructions
				    please refer to the Epson R1900 Getting Started Guide or the Video
				    Installation Guide on the Software CD provided.

BULK INK SYSTEM QuickConnect® Installation: Preparation

Check to ensure you have all components shown in both of the pictures.

1.	(1) Ink Box with Ink Multi-Cartridge
		  & Tubes attached.
2. 	 (1) Tube Support.
3. 	 (1) Side Tube Support
4. 	 (8) Individual Ink Bags.

BULK INK SYSTEM QuickConnect® Installation: Setup

1.		 Clamp the feed tubes at the box end of each line to prevent ink from entering the line as 
		  you are clipping the ink bags onto the connectors in the box wall. Insert the ink bags
		  into the reservoir box by lipping them into the connectors on the inside wall of the box.
		  Each section inside of the reservoir is marked with the color ink that should be attached
		  at each connector.

6. 	 Rubber Gloves.
7. 	 (8) Syringes for Priming (Not Shown).
8. 	 Power Driver CD (Not Shown).

1 3

4 6

25
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		  2.		 Use the priming syringe to prime each line. To do this, fill the syringe with the 
				    correct color ink. Squeeze all air from the syringe, then insert it into the bottom of the 
				    cartridge to begin the priming of the line and cartridge body. Do this for each color
				    required. Pay careful attention to the order of the colors.

3.		 Turn the printer on and press the cartridge replacement button.

4.		 The cartridge bay will shift to the remove position. Remove any installed 
		  cartridges.
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5.		 Remove the cartridge cover by using a screw driver to unclip one side.

6.		 Then twist, and push the other side to pull the cartridge cover completely out. 

7.		 Press the “Ink” Button to release the Cartridge Carriage Unit from the
		  Docking Station.
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8.		 As the Docking Station releases the Cartridge Carriage Unit, push it manually
		  toward the center of the printer.

9.		 Insert the primed Multi-Cartridge Unit in place by tilting it down toward the
		  front of the printer and sliding it into the Cartridge Carriage Unit at an angle as
		  shown above.

10.	 Once the Multi-Cartridges are in place, push them on both sides until they “click”
		  into place. 
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11.	 Manually push the Cartridge Carriage Unit back into the Docking Station. 

12.	 Remove the backing from the Plexiglas Tube Holder.

13.	 Connect the Tube Holder so that it “bridges” the Printer Control Panel as
		  shown above.
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14.	 Insert the Tubing into the Tube Holder with the black tube entering first & keeping
		  the black lines on the tubing aligned with the edges of the Tube Holder.	

15.	 Be sure to nestle the Tubing Belt as deeply as possible into the Holder. Maintain
		  a relaxed elbow as the Tubing Belt bends around to attach to the Cartridge
		  Carriage. 

16.	 Attach the Short Tube Holder to the Right Side  of the Printer where the Tube
		  Belt hangs to enter the Ink Box.
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17.	 Press the “Ink Out” Button again so that the printer recognizes the installed ink
		  cartridges.

18.	 Congratulations! You have successfully installed the R1900 QuickConnect®

		  Bulk Ink System.
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BULK INK SYSTEM QuickConnect® Installation: Tips

	 	 •	 Make sure you install ChromaBlast Driver from the CD you
			   received with your QuickConnect® Bulk Ink System. Refer to the
			   ChromaBlast Driver Documentation and the Video Tutorial on how
			   to use ChromaBlast Driver.

	 	 •	 Perform a Nozzle Check from ChromaBlast Driver. A few cleaning
			   cycles may be necessary to get a good Nozzle Check.

•	 You may want to employ the clear plastic holders to reliably prop open the printer lid so that it 	
	 remains open all of the time.

•	 There may be small pockets of air in the lines after setup. If so, these will clear after a 	
	 few prints are run.

•	 If the System is to be dormant for several days, use the Tube Clamps to seal the lines 	
	 at the Reservoir Box. Maintain the Reservoir Box at the height of the printer, never
	 raised above.
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ChromaBlast Printing and Heat Transfer Instructions
RECOMMENDED APPLICATIONS

White or light colored 100% cotton fabrics.

ChromaBlast Transfers: Step-By-Step

Once your ChromaBlast System is set up and in place, printing and transferring an 
image onto a white or light colored 100% cotton garment is a breeze. Just follow these 
simple steps, and you are on your way to creating one-of-a kind, beautiful and profitable 
products.

1.) 	Import an image (it could be a photograph from a digital camera) into your 
graphics application and manipulate it to suit your desired result. Manipulation 
may include sizing the graphic, setting the proper page margins and borders for 
printing or applying color correction if required.

2.) Load ChromaBlast paper into your printer.  The printable side is opposite the 
ChromaBlast logo.

3.) Click Print in your application and select the ChromaBlast driver as the printing 
device. Ensure that the Mirror option is selected, unless you have already reversed 
the image in your graphics application.

4.) Adjust your heat press settings.  See chart below for suggested settings.

5.)	Place the garment on the heat press, and place the ChromaBlast paper, with the 
image facing down, over the garment.  Close the heat press.

6.)	After the allotted time, release the press and move the heat platen aside. While still 
hot, and with an even motion, peel the ChromaBlast paper off the garment (hot 
peel), and stretch the image area from top to bottom and side to side to reduce the 
hand on the fabric.

IMPORTANT:  Due to variations in garments and heat presses, these settings may vary. 
For best results, test different time/ temperature combinations to find one that works best 
with your garment/ heat press combination.  Please note, higher temperatures generally 
require less time to prevent scorching.  An insufficient time/ temperature combination 
may hinder ChromaBlast from completely curing to the cotton fibers, thus resulting in 
wash out.

ChromaBlast / ChromaBlast-R (Suggested Press Parameters)
U.S. Europe

Temperature 375°F - 400° F 190°C - 204°C

Pressure 60 psi (High) 4.22 kg/cm2; 4.14 bar

Time 40 sec – 25 sec 40 sec – 25 sec

STORAGE INSTRUCTIONS

Store ChromaBlast Media in a cool, dry environment.  Do not remove media from 
protective packaging until ready to use.  Once packaging has been opened, store media 
in the plastic zip-loc bag provided.
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COLOR MANAGEMENT DRIVER V 2.0

Getting Started Guide
For the

EPSON Stylus® Photo R1900 Inkjet Printer

For Distribution With
ChromaBlast™ Ink ONLY

NOT FOR RESALE

Revision 1.0
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About Your ChromaBlast R1900 Driver  Software
Sawgrass Technologies, Inc.’s ChromaBlast  System with ChromaBlast™ Digital 
Printing Inks, featuring the Epson Stylus® Photo R1900 Ink-Jet Printer, comprise a few of 
the key tools required to ensure high quality output each time you print. ChromaBlast R1900 
Driver  Color Management Software provides everything else needed in the way of tools.

ChromaBlast R1900 Driver  Color Management Software is a professional grade color 
management program that provides  ChromaBlast™  users with the necessary tools to 
ensure colors print right the first time.  ChromaBlast R1900 Driver  software is available 
for all major Windows based operating systems. To be sure of system compatibility, 
please visit us at http://www.sawgrassink.com/v.php?pg=296.

ChromaBlast R1900 Driver  software and profiles are intended to give you simple, easy 
to use color management tools to take the guesswork out of sublimation printing.  With 
the click of your mouse you can automatically optimize colors for virtually any cotton 
substrate. This is a valuable tool that saves you time, money, and limits your need for 
costly sampling trying to get the job right.

ChromaBlast R1900 Driver  also comes standard with the ColorSure Palette matching 
system.  The ColorSure Palette is absolutely the best way to achieve spot color accuracy 
in sublimation transfers. The palette includes more than 170 colors that, when loaded 
into your graphic design software, allows you to fill solid portions of artwork with a 
color from the palette, thus knowing how it will look once transferred. With the help 
of the ColorSure Palette, you will successfully choose the correct colors, whether 
you are matching colors for a custom order or selecting colors for new artwork.

ChromaBlast R1900 Driver  is the most advanced color management software 
available on the market for digital transfer systems. This software was developed 
specifically for desktop sublimation systems; you will discover enhanced functionality 
as well as a new level of color output when ChromaBlast R1900 Driver  is used. You 
and your customers are about to truly experience the next generation in digital color!

SYSTEM REQUIREMENTS
Minimum Hardware and Recommended Operating System:

•	 A Pentium Dual Core, 3.0 GHz or higher processor is recommended.
•	 512 MB RAM is the minimum recommended memory.
•	 2 GB RAM is highly recommended to process larger documents with high quality
	 settings.
•	 5 GB of Free Hard Drive is required for proper software and file management.
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Figure 2

Figure 1

Product Overview – ChromaBlast R1900 Driver 
ChromaBlast R1900 Driver  is a color management software solution that has been 
written as a windows printer driver.  It is designed to work with Epson ink-jet printers and 
Sawgrass sublimation ink.  The installation program will automatically install the Sawgrass 
ChromaBlast R1900 Driver  Printer Driver software, and ColorSure tools and utilities.

Step By Step Installation – ChromaBlast R1900 Driver 
	 1.	 ChromaBlast R1900 Driver  installation will now begin with the assurance that 
		  the Epson Printer Driver Software is installed prior to this application.

	 2.	 The Welcome screen is displayed.  Click Next to proceed.  
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Figure 4                  

Figure 3

	 3.	 The License Agreement is displayed next.  Select the appropriate choice for 	
		  acceptance of the License Agreement to continue.

	 4.	 If you have not previously registered the ChromaBlast R1900 Driver , you will 	
		  be prompted to do so.  Registering is the only way to take full advantage of the
		  advanced features in ChromaBlast R1900 Driver .  If you choose to register 	
		  later, select Register Later and click Next to proceed with the installation.
		  (Fig. 4) You will have five days to use the program before registration will be 	
		  required 	for continued usage of the software.  After five days, if you attempt
		  to print using the PowerDriver IQ software, you will be prompted to register.
		  (Fig. 5)	
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If you decide to register later, and continue using the driver 
during the initial five day pre-registration grace period, 
your system will generate the following Pop-Up Screen. 
Go to the printing preferences page of the ChromaBlast 
R1900Driver and click on “Register.”

Figure 5

Figure 6

	 5.	 If you choose Register Now, fill in the radio button, (as shown in Fig. 6 below),
		  and click “Next”.
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Figure 7

	 6.	 In the ChromaBlast R1900 Registration Screen shown next, (Fig. 7), you 
		  will 	use your Product ID (displayed at the bottom of Figure 7), to register and 	
		  obtain a Registration Code.  A Registration Code, (or Codes), may be had in
		  any of the following ways:

			  a)		 Register on-line and receive your Registration Code via E-mail.

			  b)		 Call Sawgrass Technologies, Inc. directly (888) 253-1679 and obtain your
					    code over the Phone.

			  c)		 Send a fax and receive your Registration Code by Fax.

You must have a separate Registration Code for every machine on which 
ChromaBlast R1900 is installed.  The swiftest procedure by far is option a), by 
E-mail, in which case, in Figure 7, click on the button labeled “Click here to Obtain 
Registration Code”.
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Figure 8                 

Figure 9                 

	 7.	 The Product Registration Web Page now opens.  Complete the requested 	
		  information on the web page and click Continue.

 

	 8.	 Once the website registration information has been completed, a “Thank You” 	
		  message will appear. 
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Figure 10                  

Figure 11                 

3697521

	 9.	 After the online registration process is complete, apply the “Registration Code”
		  you’ve received in the box labelled “Registration Code”, then click “Apply Code”.

	 10.	 Your driver is now registered. Installation begins when you click “OK”.
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Figure 12                

Figure 13               

11.	Sawgrass Technologies, Inc. provides ColorSure color palettes for use with Corel
	 and Adobe.  (Check the ColorSure section of the manual for information on how to
	 use ColorSure to get perfect spot colors).  If Setup detects either of these
	 applications on your system, the palette files will be placed in the appropriate folder
	 indicated in the Destination Folder Box.  Click “Next” to proceed with the
	 installation.

12.	Please note that this process may take a few minutes depending on the hardware
	 and processing power of your unit.
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Figure 14                 

Note:	 In order to use PowerDriver as your Color Management Software,
	 the color management features in either Corel® or Adobe® Programs
	 must be disabled.  Please see the instructions in Appendix A, (Page
	 20), or click on the “Show Me How” Button on the “Color 		
	 Management Check” Screen shown in Item 12 below.

Figure 15                

	 13.	The Color Management Check screen will appear. Click the “Continue” Button
		  on the left side of the screen after you have disabled the Color Management 	
		  feature of the Corel or Adobe Graphic software. Click “Show Me How” if you
		  need instructions on how to accomplish this.

	 14. With this Screen, Installation of the ChromaBlast R1900 Driver  Driver will 	
		  begin. Click “Next” to continue.
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Figure 17           

Figure 18        

Figure 16                 

	 15.	If you see the “Hardware Installation” Screen below, click “Continue Anyway”
		  to proceed with the Installation.
 

	 16.	The installation will continue for some time, depending on the characteristics 	
		  of your hardware.

	 17.	 “ChromaBlast R1900 Driver” Installation is done. Click “OK” to continue.
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Figure 2

Note:	 Please see “Group 2 - Color Options” on page 
35 for more in-depth information on color 
options available within the ChromaBlast 
R1900  Driver.

Figure 1                 

Using the ChromaBlast Driver for the R1900
ChromaBlast R1900 is simple to use. Whenever you have ChromaBlast inks in your 
printer, you should print using the ChromaBlast Driver for the R1900.  Do not print to 
your Epson printer with the Epson Printer Driver; printing with the Epson Driver will not 
give you the benefit of color management.

Quick Start Example (Corel Draw)
	 1)	 Open/Create an image in Corel Draw.  Select “Print” from the File Menu.    

	 2)	 Select the ChromaBlast R1900  Driver.  Use the “Properties” Button (Fig. 2)
		  to access “ChromaBlast R1900  Driver Properties”.(Fig. 3, Page 32)
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Figure 3

	 3)	 In Figure 3, you must set preferences according to the printing you require,
		  either Bitmap or Vector Artwork, or “No Color Management”.  You need 	
		  also choose “Photographic” or “Graphics”,   Paper Size, Number of Copies,
		  “High Speed” or “High Quality”, “Mirror” or not, and“ColorSure”Involvement, 
		  if any. Once this is done, click “OK” to return	 to the “Print” Window (Fig. 2).
		  Here, click on “Apply”, and then “Print”.
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Figure 1

Figure 2

1

2

Setting ChromaBlast R1900 Document Properties /Printing 
Preferences
To configure ChromaBlast R1900  Driver for the correct substrate, you 
must display its Document Properties/Printing Preferences. There are 
two ways to display the Document Properties/Printing Preferences:

From the Windows Desktop:
1.	 Click on Start > Printers and Faxes.

2.	 Right-click on your ChromaBlast R1900  Driver Printer. (Point 1) Scroll 		
the Drop-Down Menu and click on “Properties”. (Point 2) This leads to the
	 ChromaBlast R1900  Driver Properties Window. (Fig. 3, Page 32)
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Figure 3

3.	 In the “ChromaBlast R1900 Properties” Window, click on the“PrintingPreferences”
	 Button near the bottom of the screen in Fig. 3.  
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Figure 4

3)	 In Figure 3, you must set preferences according to the printing you require, either
	 Bitmap or Vector Artwork, or “No Color Management”.  You need also choose
	 “Photographic” or “Graphics”,   Paper Size, Number of Copies,“High Speed” or
	 “High Quality”, “Mirror” or not, and“ColorSure”Involvement, if any. Once this is
	 done, click on “Apply”, then click “OK” to return to the “Print” Window (Fig. 2).	
	 Here, click on “Apply”, and then “Print”.
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Figure 1                  

Figure 2                  

From an Application:
1.    Select File > Print Setup.  Click to reveal “Print Setup”. (Fig. 2)

2.	 Choose the ChromaBlast R1900 Printer from the list of printers. Click the
	 Properties Button  to  access  the  ChromaBlast R1900 Document Properties.
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Figure 3                  

3)	 In Figure 3, you must set preferences according to the printing you require, either
	 Bitmap or Vector Artwork, or “No Color Management”.  You need also choose
	 “Photographic” or “Graphics”,   Paper Size, Number of Copies, “High Speed” or
	 “High Quality”, “Mirror” or not, and“ColorSure”Involvement, if any. Once this is
	 done, click “OK” to return to the “Print” Window (Fig. 2). Here, click on “Apply”,
	 and then “Print”.
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Figure 1                  

ChromaBlast R1900 Driver Properties
The Figures below show the Document Properties/Printing Preferences for a registered 
version of ChromaBlast R1900 Driver.
There are three main property groups (see the color-coded boxes in the screen shot, 
Fig. 1, Page 38):

Group (1): 	Configuration  	Set Paper Size and Copy Count.
Group (2): 	Color Settings  	Color Management Control Options.
Group (3): 	Options  	Utilities for Printer Maintenance, Online Help, Product
				    Registration, and Setting Input Profiles.

	 ChromaBlast R1900 Driver
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Group 1_Configuration: ChromaBlast R1900 Driver

Paper Size – From the drop down list, select the paper size you wish to use. (Fig. 2) 

Copies – Sets the copy count for the number of prints to be made.

Group 2_Color Settings: ChromaBlast R1900 Driver

This tab gives you access to all of the color management controls available in ChromaBlast 
R1900 Driver Tab.  Color correction allows you to create transfers from all kinds of images, 
from photorealistic images to spot color logos.  For maximum flexibility, ChromaBlast 
R1900 Driver Tab lets you color correct bitmap and vector elements differently, even if 
they are in the same graphics file.  For example, if you scan a photograph and import it 
into CorelDraw, ChromaBlast R1900 Driver Tab will use the color management settings 
that have been selected for Bitmap.  If you then add text on top of the bitmap image, 
ChromaBlast R1900 Driver Tab will use the color management settings that have been 
selected for Vector.  The photograph and the text will be color corrected differently!  
Why?  You can now sublimate images with realistic photographic backgrounds that have 
vivid spot color text.  

Vector and Bitmap Explanation
Bitmaps consist of a grid of pixels.  Bitmaps come from digital cameras, scanners, 
and photo CDs.  Bitmaps can also be created in applications like Corel PhotoPaint or 
Adobe PhotoShop.  Bitmaps have file extensions like GIF, JPG, BMP, and TIF.  Vector 
components consist of shapes, curves, lines, and text.  They are created in programs 
such as CorelDraw and Adobe Illustrator.  Higher end programs like CorelDraw can 
combine Vector and Bitmaps into a single image.  As a rule of thumb, if the object in 
your image is made of curves, text, shapes, or fills, it will be color corrected using the 
ChromaBlast R1900 Driver Tab settings.  All other image types will be color corrected 
based on the ChromaBlast R1900 Driver Tab Bitmap setting.

Bitmap & Vector Options
•	 No Color Management - All color management will be accomplished using the 	
	 Graphic Design Software.
•	 Graphics - This setting is most suitable for reproducing life-like
	 clipart.
•	 Photographic - This setting is most suitable for reproducing skin tones
	 in scanned photographs. 
•	 ColorSure Checkbox - ColorSure is used to replace specific colors in your image 	
	 with a spot color chosen from the ColorSure palette.  This resulting spot color
	 enhancement is not affected by color setting.  A ColorSure spot color will ALWAYS
	 print the same.
See Appendix C for an overview of ColorSure, Page 51.
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ColorSure Options
•	 Print Palette Button – Prints the ChromaBlast ColorSure palette for the selected
	 substrate. ColorSure is a method for reproducing exact spot colors.  The two main
	 components are: 1) the Transferred Palette and 2) the CorelDraw, and Adobe
	 Swatches.  For a complete description on how to use ChromaBlast ColorSure
	 to get perfect spot colors, see Appendix C.
•	 Custom Palette Button – This button launches the Custom Palette Utility, which
	 enables you to add, edit, import, and export custom colors to the ColorSure 		
	 Palette.  If you need to precisely match a specific color, the Color Finder Tool 	
	 makes this a breeze.  For a complete description on how to use the Custom 		
	 Palette, see Appendix C.

Output Options
•	 High Speed – If the printer supports multiple resolutions, choose the most
	 appropriate setting.  For soft substrates, the High Speed option works well.
•	 High Quality – If the printer supports multiple resolutions, choose the most
	 appropriate setting.  For hard substrates, choose the High Quality option.
•	 Mirror – When you transfer an image, the result will be “flipped” when compared 	
	 to the printed image.  In order for your transfers to come out correctly, you must 	
	 flip the image before transferring.

Group 3 – Printer Options: ChromaBlast R1900 Driver
•	 Utilities – Click this button to display a Utilities Screen.  From the Utilities Screen 
	 you can print a Nozzle Check pattern, run a print head Cleaning Cycle,align the 
	 printer’s Print Head, spool a ChromaBlast R1900 Driver print file to the printer, and
	 print a page of primary ink colors.
•	 Help – This will display a help dialog box for an easy overview of the ChromaBlast
	 R1900 Driver™  driver functions and settings.  Also contains a link to the Sawgrass
	 Technologies Website.
•	 Register – If the ChromaBlast R1900 Driver™ product has not been registered, 	
	 click this button for instructions on how to register the product and unlock all the
	 features.
•	 Input Profile – This option allows you to specify an input profile that the driver will
	 use when color correcting your image.  If you are printing scanned artwork and 	
	 your scanner manufacturer provided ICC profiles for your scanner model, select 	
	 the profile here   In order to select a profile IT MUST BE INSTALLED ON YOUR
	 MACHINE.  To install a profile on your machine, locate the profile on your machine
	 using Windows Explorer. (ChromaBlast R1900 Driver supports both ICC and ICM
	 profiletypes).  Right click on the profile file name and select “Install”.
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Figure 1                  

Figure 2                  

Appendix A:
Over-Riding Design Software Color Management
The ChromaBlast R1900 Driver  provides a complete color management solution for 
your ChromaBlast Digital Transfer Inks printing.  It is extremely important that you turn 
off any color matching features associated with your design software. An explanation of 
how to disable print-time color management in several popular design packages follows:

CorelDraw™ version X-4, X-3, 12, 11, and 10
•	 In CorelDRAW, open an existing, or create a new graphic.

•	 From the Main Menu choose Tools > Color Management. 
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•	 In the Color Management Window, set the Style option to Color Management Off.

CorelDraw™ version 9
•	 Create a new graphic.
•	 From the Main Menu choose Tools > Color Management. The Color Management 	
	 Dialog Box is displayed.
•	 In the Color Management Window (see figure below), UNCHECK the Calibrate 	
	 colors for display box.
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Adobe Photoshop CS3, CS2, CS, Photoshop 7 & 6:
	 Color Setup 
		  From the Main Menu, choose Edit, > Color Settings. In the Color Settings 	
		  Dialog Box, turn all Color Management Policies to “Off”. (See below.)  Mark
		  the box “Ask When Opening” next to “Profile Mismatches.

 

   

To Print; Adobe CS3:
Select File, > Print.  On the print dialog page, set the options as follows:
•	 Upper Right Hand Menu to “Color Management”
•	 Choose “Document” by clicking the radio button.
•	 Under “Color Handling”, choose “No Color Management”
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To Print; Adobe CS2, 
Always select File, > Print with Preview.  On the print dialog page, set the options as 
described in the following a thru d:
a.	 Click on “More Options”.

b.	 Choose Color Management in the drop-down menu.
c.	 Choose “Document” by clicking the radio button.“
d.	 Under “Options > Color Handling” choose “No Color Management”. 
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a
b
c

d

To Print; CS and Photoshop 7:
Always select File, > Print with Preview.  On the print dialog page, set the options as 
described in the following a thru d:
	 a.	 Click on “More Options”.
	 b.	 Choose Color Management in the drop-down menu.
	 c.	 Choose “Document” by clicking the radio button.
	 d.	 Choose Same as Source for Print Space.
From the Color Management drop option list, make sure that Source is set to “Document” 
and Print Space is set to “Same As Source”.
 

Adobe Photoshop Elements 5.0/4.0/3.0:
	 Select Edit and then Color Settings from the top drop down Menu Bar.  Select No 	
	 Color Management. Click Ok.
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To Print RGB Graphics
Click File, > Print, then set the Range, 
Print Quality, & Copies.

Fill in radio button “Document: 
Intagged RGB”.

In “Print Space”, “Profile” should 
read: “Same As Source”.

Press “OK”.

To Print CMYK Graphics
Click File, > Print, then set the Range, 
Print Quality, & Copies.

Fill in radio button “Document: 
Intagged CMYK”.

In “Print Space”, “Profile” should 
read: “Printer Color Management”.

Press “OK”.
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Appendix B:
Using ChromaBlast ColorSure™ and Custom Palette 
I.  Introduction
ColorSure is a method for reproducing exact spot colors.  There are four main 
components of the ColorSure System: 1) the Transferred Palette; 2) Color Finder; 3) 
Custom Palette; and 4) the CorelDRAW and Adobe application palettes / swatches.  

	 1.	 ColorSure Palette: This is your main color palette that includes a wide variety 	
		  of 190 commonly used colors.  
	 2.	 Color Finder:  If a color you need is not on the ColorSure Palette, the Color 	
		  Finder Tool allows you to locate the exact custom color you are looking for.
	 3.	 Custom Palette:  With the Custom Palette feature, you can add new custom 	
		  colors to the existing ColorSure Palette mentioned in Step 1.
	 4.	 Application Palettes:  You can add your Color Finder colors to an existing 	
		  application palette, or you can add multiple custom colors to new, custom 	
		  palette files (*.cpl, *.acl, etc.). 

II.  Printing the ColorSure Palette
			   The first step:	  Print and transfer your ColorSure Palette to the various 	
			   substrates you will be using.  Most likely you will have customers who
			   desire precise colors.  Having your ColorSure palette available allows the
			   customer to choose the color from the palette that is the closest match to
			   what they want, and this gives you a starting point for finding the exact
			   custom color that will match your customer’s needs. 

To print the ColorSure palette, follow the steps below:
	 •	 Click ‘Start’ and navigate to the ‘Printers and Faxes’ folder.  Right-click on your
		  ChromaBlast R1900 Driver   icon and select ‘Printing Preferences’ from the
		  menu. You may also open ChromaBlast R1900 Driver   from within an Adobe or
		  Corel program by going to File, Print, and choosing the ChromaBlast Driver
		  R1900 printer from the pull-down menu.  Click “Properties” to open
		  PowerDriver R1900 IQ. Select the ChromaBlast R1900 Driver Tab.
	 •	 Choose the paper size you will be printing the palette to (Letter, Legal, etc).
	 •	 Choose the substrate that you will be transferring the palette to.
	 •	 Select the speed / resolution of the palette – High Speed or High Quality.
	 •	 Be sure to check the box to mirror your print, click ‘Print Palette,’ and then 	
		  transfer the palette to the previously selected substrate.
	 •	 You now have a visual representation of how the ColorSure Palette colors will 	
		  appear on that particular substrate.
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HINT
After you have the ColorSure Palette loaded into CorelDraw, move the 
cursor over each color.  As the cursor hovers over each different color, 
the ColorSure Name is displayed in the status area below each color.

2

1

III.  Designing Your Artwork
By picking colors from the ColorSure palette, you will be able to consistently reproduce 
colors in a reliable manner.  To assist you in designing your artwork, PowerDriver 4880 
and ChromaBlast 4880 install three palettes:  two for Adobe products and one for Corel 
products.  These colors match the palette that is printed from within PowerDriver and 
the ChromaBlast driver. 
	 •	 To open the ColorSure Palette in Corel 9, 10, 11, 12, X3, and X4, choose Window
		  > Color Palettes > Open Palette.  Select the file “ColorSure PaletteCorel.cpl”
	 •	 To open the ColorSure Palette in Adobe Illustrator, (Colorsure Palette.aco)
		  choose Window > Swatch > Libraries > Other Library.  Navigate to its Installation
		  Destination set during PowerDriver  installation: C:\Program Files \Sawgrass
		  \PowerDriver \Adobe Illustrator and hit Open. For easier access to the Palette
		  File, copy it from this installation path to Illustrator10 \Presets \Swatches and
		  it will show up in your Drop-down list directly under the Swatch Libraries Menu.
		  Other versions of Illustrator will have similar steps.
	 •	 To open the ColorSure Palette in Adobe PhotoShop, (Colorsure Palette.aco) 
		  choose the “Swatches Palette”, click the option arrow on the palette, (Point 1),
		  choose Replace Swatches, (Point 2), and pick the “Colorsure Palette.aco file.

 

IV.	Using Color Finder
After printing and transferring the ColorSure Palette, you see that you have an array 
of colors to work with.  There will be times, however, when the color you need is not 
included in the ColorSure Palette.  This is where the Color Finder Tool comes in handy.  
The Color Finder Tool allows you to start with a specific color (e.g. navy blue) and find 
similar colors in the same family by adding and subtracting up to three colors called
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Figure 1

Figure 2
Figure 3

Slider
Bar

Color Chooser Dialog Window

•	 To use Color Chooser, simply click on the‘Start
	 Color Chooser’ button in the “Color Finder”
	 Section, at the top right of the “ChromaBlast
	 Custom Palette Utility” Window.  You can then
	 choose a color from the basic color selection, or
	 you can click on the Color button at the right of
	 the window.  This will display a color matrix.  To
	 define a custom color, click anywhere in the matrix.
	 Use the slider at the right of the matrix to adjust
	 luminosity. Clicking ‘OK’ will automatically fill the
	 RGB boxes with the corresponding values. (Fig. 3)	
•	 For advanced users, RGB values can be
	 determined by printing out a Custom Palette,
	 which is outlined in the next section.

‘Step Colors.’  For example, starting with navy blue with a CMYK value of 60,60,0,40 
and choosing two step colors (e.g. cyan and magenta) would expand the original navy 
blue in four directions (more cyan, less cyan, more magenta, and less magenta).  This 
expanded color chart – specific to a particular substrate and printing speed – is outputted 
directly to your printer.

How to use Color Finder:
	 •	 Open the ChromaBlast R1900 Driver  Window as instructed in “Printing the
		  ColorSure Palette” outlined in Section II.
	 •	 At the bottom of the window, click the Custom Palette Button; this will open
		  the 	“Custom Palette Utility” Window.  (Figure 1)
	 •	 First, make sure you select your desired Substrate, Output (High Speed or High 
		  Quality), and the Mirror option from the Printing Preferences Window.  Click
		  Apply at the bottom of the window.  This is a very important step as it will
		  affect the final printed output. (Figure 2)
	 •	 Click on Color Chooser and select your desired starting color from the matrix. 
		  If you do not wish to use Color Chooser, you have the option to manually enter
		  the Start Color values in the CMYK boxes. (Figure 3, page 51.)
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Custom Palette Utility
You may alter the chosen color’s CMYK value by selecting two or three Step Colors.
Using multiple step colors will present you with a greater range and variety of colors to 
choose from.
	 •	 For instance, if you choose to modify your Start Color with two steps,then Step
		  Color 1 will change its values on the X (horizontal) axis and Step Color 2 will
		  change its values on the Y (vertical) axis.  

Color Finder Palette with two Step Colors
	 •	 If you modify your Start Color with three steps, Step Color 1 will remain the 	
		  same.  However Step Color 2 and Step Color 3 will form an imaginary ‘X’ and 	
		  their values will change on opposing diagonal Y axes.

   

Color Finder Palette with three Step Colors



Sawgrass Technologies, Inc. ~ www.sawgrassink.com
48

	 •	 Next, determine what Step Size you want to apply to the Color Finder Palette.  	
		  This is simply a question of how much you want your Start Color to fluctuate.  
	 •	 If your Start Color is close the color you are looking for, use a low Step Size 	
		  (i.e. 	5-10).  However, if your start color is not close to what you are looking 	
		  for, 	use a higher Step Size.
	 •	 You can enter any Step Size value between 1 and 40.
	 •	 As an example, let’s say your Start Color is C:20, M:100, Y:150, K:0 and you 	
		  select Cyan and Magenta to be your Step Colors.  You also enter a Step Size 	
		  of 10.  When the ‘Print Colors’ Button is clicked,  your Start Color will be in 	
		  the middle of the Color Finder Palette and from there each color will vary the 	
		  Cyan and Magenta values by 10.
	 •	 When you are finished selecting the Start Color, Step Colors, and the Step 	
		  Size, click on the Print Colors Button.  This will print your custom Color 	
		  Finder Palette directly to your printer.
	 •	 After printing the Color Finder Palette, transfer it to your selected substrate 	
		  and 	then try to match your desired color to one that is on the palette.  If you 	
		  find 	a suitable match, you are finished using the Color Finder Tool.  Move on 	
		  to Section V. “The Custom Palette”. 
	 •	 If you couldn’t find an accurate match on the first printed Color Finder 		
		  Palette, don’t worry.  Follow the easy steps below, and you can find a more
		  suitable custom color.

To Find More Custom Colors

	 1.	 First, try to locate a new Start Color from the palette that is closer than the 	
		  original color.

	 2.	 Next, after finding a more suitable Start Color, write down that color’s CMYK 	
		  value.  Here is how to obtain this value.  There are numbers under each color 	
		  that are dependant upon which Step Colors you chose.  For example, it might 	
		  say C:70 M:120.  Take note of these values.  Then, at the bottom left of the 	
		  Color Finder Palette you will see a full set of CMYK values.  The new Start 	
		  Color’s CMYK value would be C:70, M:120 and whatever the Y&K values are 	
		  from the full set.

	 3.	 Lastly, plug the CMYK values for the new Start Color into the boxes in Color 	
		  Finder, choose your Step Size, and click on Print Colors once again.  
		  Continue with steps 1-3 until you find your desired color.
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V.	 The ChromaBlast Custom Palette
Let us assume that you have found the exact color you need using the Color Finder Tool.  
What you will want to do next is apply these custom color values to either an existing 
palette, or to create a new custom palette altogether.  This allows you access to this color 
again should the same job arise.  

How to use Custom Palette:
	 •	 First, you need to assign the CMYK values of the matched color from the Color
		  Finder Palette to the Output Color CMYK fields in the Custom Palette section.

	 •	 Give your new custom color a descriptive Name in its designated field
		  (e.g. IBM Blue).

	 •	 Next, assign an “RGB Input Color” Value.  There are two methods to establish 
		  this value.

	 1.	 If you have the original file, sample the color that was matched in your graphic
		  design application with the eye dropper tool.  This will give you the RGB value
		  of that color.  Input this value into the RGB Input Color fields of the CustomPalette
		  Section.

	 2.	 If you do not have the original file, or the artwork has not yet been designed,simply 
		  click on the ‘Input Color Chooser’ button, and then click on “Define Custom
		  Colors”.  From the color matrix, find a color that closely resembles the color 
		  that you are adding to the custom palette.  At the bottom-right of the colormatrix 
		  window are the RGB values.  Simply click ‘OK’ and the RGB InputColor values 
		  will be automatically entered.  Please take note of these RGB values for later use
		  in your design applications.

	 •	 Click the “Add Color” Button.  A window will pop up asking you whether you
		  want to add the color to the palette for all substrates, or just the currentsubstrate.
		  Click ‘YES’ here unless you have the same custom color saved on palettes for
		  other substrates.  Another window will then ask you if you want to save the
		  custom color for all resolutions or just the current one.  Click ‘YES’here unless
		  you have the same custom color saved on palettes for other resolutions.

	 •	 Lastly, click the “Save Palette” Button.  When finished, simply Exit out of the
		  window.

					     The ‘Import Palette’ and ‘Export Palette’ Buttons are convenient to
					     have in the event you need to transfer palettes to and from different
					     computers.

VI.	Adding Swatches to your ChromaBlast Application Palette:
It is possible to add your custom color(s) swatch to an application palette as well.  You 
will need to take note of the Input Color RGB value that you assigned in the previous step 
in order to create the new swatch.  Refer to your specific design application software’s 
manual for instructions on this.
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Supplies & Equipment 
Contact your authorized reseller to purchase sublimation supplies and equipment. For 
more information, see the Dealer Directory on our website at www.sawgrassink.com.

Operating Conditions
Certain environmental conditions should be taken into account for the operation of 
ChromaBlast Inks, including temperature and relative humidity.

	 ChromaBlast
	 •	 Supported operating Conditions are 65° – 80° F with 35 – 60% relative 		
		  humidity
	 •	 Optimum operating Conditions are 70° – 75° F with 40 – 50% relative 		
		  humidity

Storage
	 •	 Care should be taken to prevent storing ChromaBlast inks below freezing
		  temperatures (32°F, 0°C). Do not expose these inks to extreme 
		  heat (temperatures in excess of 104°F, 40°C). If these inks have been in storage,
		  you should allow them to reach room temperature before using them.  

	 •	 Do not expose ChromaBlast cartridges directly to light, especially sunlight, for
		  extended periods. 

	 •	 For best results, install your ChromaBlast cartridges by the date on the
		  cartridge. Please refer to the individual ink bag/cartridge for the specific
		  ink expiration date.

Storage Instructions
Store ChromaBlast Media in a cool, dry area within the provided plastic storage bag.  Do 
not remove from carton until ready to use.
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Troubleshooting
The troubleshooting tips found in this section relate mainly to problems that can be 
seen in transferred ChromaBlast images. If you are having problems related to the 
performance of your printer, please refer to the Problem Solving section found in the 
Epson Stylus Photo R1900 Printer Quick Reference Guide.

The colors in my transferred image are incorrect.
	 •	 The image may need color adjustment. Use the driver color matching software.
		  For more information on how to use this software, please see the relevant User 
		  Guide Sections on Color Management.

	 •	 Ensure you used the right Printer Driver and driver settings. Please see the
		  relevant User Guide Sections related to Software.

	 •	 Ensure you pressed the item with the proper time, temperature, and pressure.
		  For guidelines see the section entitled ChromaBlast Transfer Instructions,
		  Page 8.

	 •	 Verify that all colors print correctly. Run the Nozzle Check utility and clean the
		  print heads as required.

My printout is really light on paper.
	 ChromaBlast Ink naturally looks muted before heat transferrance of the image. After
	 transferring is complete, ChromaBlast’s unique inks will produce a brilliant and 	
	 durable final product. 

My printout gets cut off on the bottom or side.
	 •	 Verify the printer driver is setup for the correct paper size. Your printer driver
		  setting needs to match the paper size that is loaded in your printer.

	 •	 Ensure the right paper guide is in the proper position. When setting up the
		  printer,slide the right paper guide to the left until it clicks into position.

My image looks good but it washes out.
	 •	 Ensure you pressed the garment with the proper time, temperature, and
		  pressure. If so, try pressing longer to ensure that the dyes are penetrating the 
		  fibers sufficiently. For guidelines, see the section entitled  ChromaBlast Heat
		  Transfer Instructions.

	 •	 With ChromaBlast, ensure you used the recommended ChromaBlast v1.5
		  Media and Inks.

	 •	 Ensure your substrate is designed to accept sublimation transfers. Garments
		  made from natural fibers, such as cotton, are not compatible with the
		  sublimation process.

Colors are light and splotchy.
	 •	 Ensure you printed on the correct side of the paper or other media. With paper, 
		  the print side is the bright white side.



Sawgrass Technologies, Inc. ~ www.sawgrassink.com
52

	
	 •	 Ensure you pressed the item with the proper time, temperature, and pressure.
		  For guidelines, see the section entitled ChromaBlast Transfer Instructions,
		  Page 8.
	 •	 Verify your printer driver settings are correct. Please see the relevant section
		  of the User’s Guide for  additional information.
	 •	 Ensure your substrate is designed to accept a ChromaBlast transfer. Garments
		  made from natural fibers such as Cotton are compatible with the ChromaBlast
		  sublimation process.

My image looks blurred.
	 •	 Ensure you pressed the item with the proper time, temperature, and pressure.
		  For guidelines, see the section entitled ChromaBlast Transfer Instructions,
		  Page 8.
	 •	 Ensure you printed on the correct side of the media. The print side
		  is opposite the LOGO side of the media.
	 •	 Verify that the printer’s print heads are properly aligned. For further instructions, 
		  see the Epson Stylus Photo Printer Quick Reference Guide.

My image has gaps or bands present.
	 •	 Ensure that all of the printer’s nozzles are firing properly.  Perform a Nozzle
		  Check from the Utility Tab of your printer driver. For further instructions, see
		  the Epson Stylus Photo Printer Quick Reference Guide.
	 •	 If one or more of the nozzles fail to print, perform a Print Head Cleaning. For
		  Further instructions, see the Epson Stylus Photo Printer Quick Reference Guide.
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Technical Support
If you are having difficulties achieving good results from your ChromaBlast 
Inks, you have several support options:
1.	 Telephone: You may contact your authorized ChromaBlast reseller
	 during their normal hours of operation for assistance. A full listing of authorized
	 ChromaBlast Resellers is available on our Web Site at
	 www.sawgrassink.com. In addition, you may also contact Sawgrass Technical
	 Support at (888) 253-1679 between the hours of 8:30 AM and 5:30 PM Eastern
	 Standard Time. 

2.	 Internet: Visit the Technical Support area of the Sawgrass Technologies, Inc.’s
	 Web Site at www.sawgrassink.com.  The troubleshooting utility found here will
	 provide you with solutions to some of the most common problems.  You may
	 submit a detailed description of your problem if you need further assistance. 

3.	 E-mail: You may e-mail Sawgrass Technical Support with a detailed description
	 of your problem at support@sawgrassink.com. 

4.	 Fax: You may fax a detailed description of your problem to Sawgrass Technical
	 Support at (843) 849-3847.
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Notes:






